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TI Designs
Interrupt-Based Ambient Light and Environment Sensor
Node for Sub-1GHz Networks Reference Design

TI Designs
This TI Design demonstrates a low-power method of
wireless environmental sensing enabling up to
10 years of battery life. This design uses Texas
Instruments’ SimpleLink™ ultra-low power sub-1GHz
wireless microcontroller (MCU) platform, and ambient
light, humidity, and temperature sensing technologies
to achieve interrupt-based sensor monitoring when
running from the backup battery.

Design Resources

TIDA-00758 Design Folder
CC1310 Product Folder
OPT3001 Product Folder
HDC1000 Product Folder
TPD1E10B06 Product Folder
TIDA-00488 Tool Folder
TIDA-00100 Tool Folder

ASK Our E2E Experts

Design Features
• Supports Interrupt Mode Radio Wake-up Triggered

by Indoor Lux Levels
• Long Backup Battery Life (up to 10 Years)
• Monitors Ambient Light to Precisely Control a

Building’s Lighting System
• Senses Ambient Humidity and Temperature to

Control the Building’s HVAC System

Featured Applications
• Smart Lighting
• Daylight Harvester
• Environmental Sensing Nodes
• Wireless Sensor Node
• Internet of Things (IoT)
• HVAC Sensors
• Building Automation

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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http://www.ti.com/product/CC1310
http://www.ti.com/product/OPT3001
http://www.ti.com/product/HDC1000
http://www.ti.com/product/TPD1E10B06
http://www.ti.com/product/TIDA-00488
http://www.ti.com/product/TIDA-00100
http://e2e.ti.com
http://e2e.ti.com/support/applications/ti_designs/
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1 Key System Specifications

Table 1. Key System Specifications

PARAMETER SPECIFICATION DETAILS
Non-rechargeable battery CR2032 Lithium-ion coin cell battery (3.0-V nominal voltage) Section 2.5

Sensor type Ambient light, humidity, temperature Section 2.1; Section 2.2;
Section 2.3

Measurement interval Sensor measurements once every 800 ms Section 6.1
Average off-state current
consumption 2.1 µA Section 6.2

On-state duration 54 ms Section 6.1; Section 6.3
Off-state duration Variable Section 6.2; Section 6.3

Light level trip point
250 lux (lower level)

Section 6.4
600 lux (upper level)

Working environment –30°C to 60°C Section 2.5
Form factor 2.0×3.0-inch rectangular PCB Section 5.1

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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2 System Description
Many industrial, building automation, and IoT systems require increasing numbers of wireless sensor
nodes. Power distribution and consumption are two of the major constraints of adding many wireless
sensor end-nodes to a system. Typical sensor end-nodes are powered by batteries, which last from
several months to several years depending on the power consumption of the end node. Replacing
batteries can increase the system-level cost significantly, so it is important to ensure the sensor node uses
very little power to guarantee long battery life.

Additionally, many building automation systems are beginning to require ambient light sensors to monitor
the effect of varying levels of natural light in the building.

Figure 1. Light Sensing for Building Automation

By smartly monitoring the ambient light level, the effects of the sun coming out from behind clouds, or
conversely, the natural light level decreasing due to clouds or nighttime, can be mitigated. Light control
could happen through a number of methods, including automatic blind operation and artificial light level
adjustments.

A major tradeoff exists between battery life and frequency of data collection for sensor nodes. If very
frequent (1 to 10 seconds) data collection and transmission is required, then batteries must either have a
very large capacity or be changed very frequently.

Enabled by Texas Instruments’ SimpleLink ultra-low power wireless MCU platform, ambient light sensing,
and humidity sensing technologies, the Interrupt-Based Ambient Light and Environment Sensor Node for
Sub-1GHz Networks Reference Design TI Design demonstrates an interrupt-based ambient light sensor
powered by a CR2032 coin cell.

This design guide addresses component selection, design theory, and the testing results of this TI Design.
The scope of this design guide gives system designers a head start in integrating TI’s SimpleLink ultra-low
power wireless MCU platform, ambient light sensor, and humidity sensor technologies.

This design is a companion design to the TIDA-00488. The basic circuitry is the same except the
TIDA-00488 uses solar cells and a capacitor power bank as renewable energy storage. Different software
is provided to allow different functionality on the TIDA-00758.

2.1 Interrupt-Based Ambient Light Sensing
The TIDA-00758 is designed for situations where the ambient light level is not expected to change
dramatically or often. The wireless MCU is programmed to only wake up when the light level has
fluctuated by a certain amount. Only then would the MCU read the sensor data and transmit back to a
central controller. Since the sensor node will only be waking up several times an hour, a simple CR2032
coin cell battery can power the sensor node and still maintain nearly 10 years of battery life.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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2.2 Ambient Light Sensor
In this TI Design, an ambient light sensor provides an extremely accurate ambient light measurement that
very closely matches the spectrum of the human eye. Knowing an accurate ambient light level enables
smart buildings to accurately and intelligently control the environmental conditions to increase occupants’
comfort and energy performance of the building.

The OPT3001 from Texas Instruments has flexible operating modes. The continuous measurement mode
and threshold interrupt features of the OPT3001 are used in this design because the ambient light sensor
must wake up the wireless MCU only when the ambient light level has exceeded pre-set thresholds.

The OPT3001 is ideally suited for sensing lighting due to its ambient light linearity of 2% and rejection rate
of infrared (IR) light greater than 99%. Furthermore, the OPT3001 has extremely low power consumption
with an average current of 1.8 μA and an average shutdown current of 0.3 μA. Connecting the wireless
MCU to this device is straightforward using an I2C interface.

2.3 Humidity and Temperature Sensor
In this TI Design, a humidity and temperature sensor was incorporated to demonstrate multiple sensing
options. Similar to ambient light sensing, humidity and temperature are common measurement parameters
in industrial and building automation applications.

With a relative humidity accuracy of ±3% and a temperature accuracy of ±0.2°C, the HDC1000 can
accurately sense humidity and temperature data. The HDC1000 is a very low power device, averaging 1.2
μA at a one sample per second measurement rate when active and 200 nA or less when in sleep mode.
Connecting the wireless MCU to this device is straightforward using an I2C interface.

2.4 Ultra-Low Power Wireless MCU
In this TI Design, transmitting the sensor information to a central location for processing is necessary.
However, because power consumption is always a concern in battery-powered applications, the radio and
processor must be low power. Also, the wireless protocol required for the end-equipment system is an
important consideration for the selection of the radio device.

The TI CC1310 SimpleLink ultra-low power wireless MCU platform is a low-power device with a combined
radio and MCU. The CC1310 enables extremely long battery life for sensor end-nodes. Furthermore, the
CC1310 is a multi-standard device with software stack support for wM-Bus and TI’s SimpliciTI™ star
network protocol. In this TI Design, a generic proprietary protocol was implemented, but the hardware can
work with other protocols as well.

2.5 Coin Cell Battery
For this TI Design, a CR2032 lithium-ion coin cell battery is the primary power source for the interrupt-
based mode of operation. This battery type was chosen due to do its ubiquity and small size.

The voltage characteristics for the CR2032 lithium coin cell are ideal as well. The output voltage of the
battery is relatively constant until the battery is nearly depleted. At this stage, the voltage begins to
decrease exponentially until the battery is depleted in full.

The temperature characteristics of lithium-ion batteries are superior to that of alkaline cells. However, the
operating temperature range of the CR2032 is more limiting than the other components used in this
design. Therefore, the temperature range of this TI Design is –30°C to 60°C.

Following the battery is a Schottky diode. This diode prevents damage to the other components used in
this design in the case that the battery is inserted backwards. A bulk capacitor is placed in parallel with the
battery to provide an energy buffer, which will prevent the battery voltage from sagging during significant
current draw events. In this TI Design, the wireless MCU transmission is the source of such current draws.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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3 Block Diagram

Figure 2. Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz Networks
Reference Design System Block Diagram

3.1 Highlighted Products
The Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz Networks Reference
Design TI Design features the following devices:
• CC1310: SimpleLink Sub-1 GHz Ultra-Low Power Wireless MCU (Section 3.1.1)
• OPT3001: Digital Ambient Light Sensor (ALS) With High Precision Human Eye Response

(Section 3.1.2)
• HDC1000: Low Power, 3% Accuracy Digital Humidity Sensor With Integrated Temperature Sensor

(Section 3.1.3)
• TPD1E10B06: Single-Channel ESD in 0402 Package With 10-pF Capacitance and 6-V Breakdown

(Section 3.1.4)

For more information on each of these devices, see their respective product folders at www.ti.com.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
http://www.ti.com
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3.1.1 CC1310
The CC1310 is the first part in a Sub-1GHz family of cost-effective, ultra-low power wireless MCUs. The
CC1310 combines a flexible, very-low power RF transceiver with a powerful 48-MHz Cortex®-M3 MCU in
a platform supporting multiple physical layers and RF standards. A dedicated Cortex-M0 MCU is handling
low-level RF protocol commands that are stored in ROM or RAM, thus ensuring ultra-low power and
flexibility. The low-power consumption of the CC1310 does not come at the expense of RF performance;
the CC1310 has excellent sensitivity and robustness (selectivity and blocking) performance. The CC1310
is a highly integrated solution offering a complete RF system solution, which includes an on-chip DC-DC
converter into a true single-chip solution down to a 4×4-mm package.

Sensors can be handled in a very low power manner by a dedicated autonomous ultra-low power MCU
that can be configured to handle analog and digital sensors; thus, the main MCU (Cortex-M3) sleeps for
as long as possible. Software stack support for this device is as follows:
• wM-Bus
• SimpliciTI (star network)

Figure 3. CC1310 Functional Block Diagram

Features:
• MCU:

– Powerful ARM® Cortex-M3
– EEMBC CoreMark score: 142
– Up to 48-MHz clock speed
– 128KB of in-system programmable flash
– 8KB SRAM for cache
– Up to 20-KB of ultra-low leakage SRAM
– 2-Pin cJTAG and JTAG debugging
– Supports over-the-air (OTA) upgrade

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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• Ultra-low power sensor controller:
– 16-bit architecture
– 2KB of ultra-low leakage SRAM for code and data

• Efficient code size architecture, placing peripheral drivers, RTOS, RF drivers, and bootloader in ROM
• RoHS-compliant packages:

– 4×4-mm RSM QFN32 (10 GPIOs)
– 5×5-mm RHB QFN32 (15 GPIOs)
– 7×7-mm RGZ QFN48 (30 GPIOs)

• Peripherals:
– All digital peripheral pins can be routed to any GPIO
– 4 general-purpose timer modules (8×16-bit or 4×32-bit timer, PWM each)
– 12-bit ADC, 200-ksps, 8-channel analog MUX
– Continuous comparator
– Ultra-low power analog comparator
– Programmable current source
– UART
– 2 × SSI (SPI, µW, TI)
– I2C
– I2S
– Real-time clock (RTC)
– AES-128 security module
– True random number generator (TRNG)
– Support for eight capacitive sensing buttons
– Integrated temperature sensor

• External system:
– World’s smallest sub-1 GHz wireless MCU: 4 × 4 mm
– On-chip internal DC-DC converter
– Very few external components
– Seamless integration with the SimpleLink CC1190 range extender
– Pin compatible with the SimpleLink CC26xx

• Low power:
– Wide supply voltage range:

• Normal operation: 1.8 to 3.8 V
• External regulator mode: 1.65 to 1.95 V

– Active-mode RX: 5.5 mA
– Active-mode TX at 10 dBm: 12 mA; 14 dBm: 25 mA
– Active-mode MCU: 61 µA/MHz
– Active-mode MCU: 48.5 CoreMark/mA
– Active-mode sensor controller: 8.2 µA/MHz
– Standby: 0.7 µA (RTC running and RAM/CPU retention)
– Shutdown: 100 nA (wakeup on external events)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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• RF section:
– Excellent receiver sensitivity:

• –121 dBm at 2.4 kbps
• –111 dBm at 50 kbps

– Very good selectivity and blocking performance
– Data rate up to 4 Mbps
– Modulation support: MSK, FSK, GFSK, OOK, ASK, 4GFSK, CPM (shaped-8 FSK)
– Highly flexible RF modem (software-defined radio) to also cover legacy and proprietary

communication protocols
– Programmable output power up to 15 dBm with shared RX and TX RF pins (regulated power

supply)
– Antenna diversity
– Coding gain
– Suitable for systems targeting compliance with worldwide radio frequency regulations:

• ETSI EN 300 220, EN 303 131, EN 303 204 (Europe)
• FCC CFR47 Part 15 (US)
• ARIB STD-T108 (Japan)

• Tools and development environment:
– Full-feature and low-cost development kits
– Multiple reference designs for different RF configurations
– Packet sniffer PC software
– Sensor controller studio
– SmartRF™ Studio
– SmartRF Flash Programmer 2
– IAR Embedded Workbench® for ARM
– Code Composer Studio™

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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3.1.2 OPT3001
The OPT3001 is a sensor that measures the intensity of visible light. The spectral response of the sensor
tightly matches the photopic response of the human eye and includes significant infrared rejection.

The OPT3001 is a single-chip lux meter, measuring the intensity of light as visible by the human eye. The
precision spectral response and strong IR rejection of the device enables the OPT3001 to accurately
meter the intensity of light as seen by the human eye regardless of light source. The strong IR rejection
also aids in maintaining high accuracy when industrial design calls for mounting the sensor under dark
glass for aesthetics. The OPT3001 is designed for systems that create light-based experiences for
humans, and an ideal preferred replacement for photodiodes, photoresistors, or other ambient light
sensors with less human eye matching and IR rejection.

Measurements can be made from 0.01 lux up to 83k lux without manually selecting full-scale ranges by
using the built-in, full-scale setting feature. This capability allows light measurement over a 23-bit effective
dynamic range.

The digital operation is flexible for system integration. Measurements can be either continuous or single-
shot. The control and interrupt system features autonomous operation, allowing the processor to sleep
while the sensor searches for appropriate wake-up events to report through the interrupt pin. The digital
output is reported over an I2C- and SMBus-compatible, two-wire serial interface.

The low power consumption and low power supply voltage capability of the OPT3001 enhance the battery
life of battery-powered systems.

Figure 4. Spectral Response of OPT3001 and
Human Eye

Figure 5. OPT3001 Functional Block Diagram

Features:
• Precision optical filtering to match human eye:

– Rejects > 99% (typ) of IR
• Automatic full-scale setting feature simplifies software and ensures proper configuration
• Measurements: 0.01 lux to 83k lux
• 23-bit effective dynamic range with automatic gain ranging
• 12 binary-weighted full-scale range settings: < 0.2% (typ) matching between ranges
• Low operating current: 1.8 µA (typ)
• Operating temperature range: –40°C to 85°C
• Wide power-supply range: 1.6 to 3.6 V
• 5.5-V tolerant I/O
• Flexible interrupt system
• Small-form factor: 2.0 × 2.0 × 0.65 mm

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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3.1.3 HDC1000
The HDC1000 is a digital humidity sensor with integrated temperature sensor that provides excellent
measurement accuracy at very low power. The device measures humidity based on a novel capacitive
sensor. The humidity and temperature sensors are factory calibrated. The innovative Wafer Level Chip
Scale Package (WLCSP) simplifies board design with the use of an ultra-compact package. The sensing
element of the HDC1000 is placed on the bottom part of the device, which makes the HDC1000 more
robust against dirt, dust, and other environmental contaminants. The HDC1000 is functional within the full
–40°C to 125°C temperature range.

Figure 6. HDC1000 Functional Block Diagram

Features:
• Relative humidity (RH) operating range: 0% to 100%
• 14-bit measurement resolution
• Relative humidity accuracy: ±3%
• Temperature accuracy: ±0.2 °C
• 200-nA sleep mode current
• Average supply current:

– 820 nA at 1sps, 11-bit RH measurement
– 1.2 µA at 1sps, 11-bit RH and temperature measurement

• Supply voltage: 3 to 5 V
• Tiny 2×1.6-mm device footprint
• I2C interface

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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3.1.4 TPD1E10B06
The TPD1E10B06 device is a single-channel electrostatic discharge (ESD) transient voltage suppression
(TVS) diode in a small 0402 package. This TVS protection product offers ±30-kV contact ESD, ±30-kV
IEC air-gap protection, and has an ESD clamp circuit with a back-to-back TVS diode for bipolar or
bidirectional signal support. The 12-pF line capacitance of this ESD protection diode is suitable for a wide
range of applications supporting data rates up to 400 Mbps. The 0402 package is an industry standard
and is convenient for component placement in space-saving applications.

Typical applications of this ESD protection product are circuit protection for audio lines (microphone,
earphone, and speaker phone), SD interfacing, keypad or other buttons, VBUS pin and ID pin of USB
ports, and general-purpose I/O ports. This ESD clamp is good for the protection of the end equipment like
ebooks, tablets, remote controllers, wearables, set-top boxes, and electronic point of sale equipment.

Figure 7. TPD1E10B06 Functional Block Diagram

Features:
• Provides system-level ESD protection for low-voltage IO interface
• IEC 61000-4-2 level 4
• ±30-kV (air-gap discharge)
• ±30-kV (contact discharge)
• IEC 61000-4-5 (surge): 6 A (8/20 μs)
• IO capacitance: 12 pF (typical)
• RDYN: 0.4 Ω (typical)
• DC breakdown voltage: ±6 V (minimum)
• Ultra-low leakage current: 100 nA (maximum)
• 10-V clamping voltage (maximum at IPP = 1 A)
• Industrial temperature range: –40°C to 125°C
• Space-saving 0402 footprint (1.0 × 0.6 × 0.5 mm)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B
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4 System Design Theory
The Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz Networks Reference
Design TI Design measures ambient light, relative humidity, and temperature, while achieving an
extremely long battery life. This system is intended for applications that have a relatively constant ambient
light level and only rare anomalies that need to be reported. The system uses the intelligence in the
OPT3001 to wake up the CC1310 wireless MCU only when required, thus saving power and achieving
nearly 10 years of battery life on a single CR2032 coin cell.

The following sections describe in more detail the theory used to properly design this sensor node.

4.1 Interrupt-Based Ambient Light Sensing Design Theory
The Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz Networks Reference
Design firmware is designed to work only when the ambient light goes outside of a set range. The
OPT3001 is configured with internal thresholds. An interrupt pin will be activated if either the upper or
lower ambient light level threshold is exceeded. Only at that time will the CC1310 wireless MCU be woken
up to read the ambient light data and transmit a wireless packet.

4.1.1 Battery Life Span
When running the system, the following parameters affect the entire system:
• Capacity rating of battery (mAh)
• Average off-state current consumption (nA)
• Off-state duration (s)
• Average on-state current consumption (mA)
• On-state duration (s)

Equation 1 describes the estimated battery life for this design:

(1)

Where:
• TON = TONINTERVAL × NTIMES

• TOFF = T – TON

• T = TON + TOFF

To obtain a longer battery life, optimize the following factors:
• Longer TOFF for each device
• Shorter TON for each device
• Lower ION and IOFF for each device
• Lessen the NTIMES the device is on

T is the total system duration that the user wishes to use in the calculation. When choosing a timing
period, pick an interval that you can expect an equivalent number of interrupts occurring. For instance, in
this TI Design it was estimated around 10 interrupts would be transmitted each hour. Therefore,
T = 1 hour for the battery life theory calculation of this design.

ION is the average current consumed by the sensor nodes and wireless MCU during the on-duration. The
greatest amount of current used by this system is by the CC1310 when it is transmitting a signal.
Therefore, to have a longer battery life, try to reduce the amount of signals transmitted. Conversely, IOFF is
the average current consumed by the sensing devices and wireless MCU during the off-duration. IOFF is a
result of the OPT3001 continuously collecting data by being set to its active mode, while the HDC1000
and the CC1310 are in their shutdown modes. Therefore, it is important to have an interrupt-reporting
device that has negligibly small current while active, which the OPT3001 achieves.

http://www.ti.com
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4.2 Firmware Design
The firmware is designed to implement interrupt-based sensing, where data packets will only be
transmitted when a fault light condition occurs. The mode can be configured using the
"OPT_CONFIG_METHOD" definition in opt3001.h.

The flowchart shown in Figure 8 consists of the CC1310 operating in interrupt-based transmission mode.
The device starts by checking the source of the wireless MCU wakeup. If the wireless MCU is woken up
by reset, which means it is the first time the CC1310 is running, the OPT3001 will be configured to run in
continuous mode and trigger the wireless MCU wake up when the light level is either too low or too high.
For this design, the lower light threshold is set for 250 lux and the upper threshold is set for 600 lux. The
OPT3001 will provide interrupts to the CC1310 only if the light level is below 250 lux above 600 lux.

If the CC1310 is woken up by the OPT3001 pin interrupt, it means the OPT3001 has detected a fault light
condition. The CC1310 will first acquire the temperature, humidity and light data. Because the HDC1000
has a higher operating voltage compared to the OPT3001 and CC1310, a check is added to make sure
that the HDC1000 is still functioning (for example, at a low coin cell battery). If the voltage is too low for
the HDC1000 to function properly, the HDC1000 conversion is aborted and dummy HDC data will be
used. Once all the data is acquired, the CC1310 will transmit a packet with the data.

Afterwards, the CC1310 will re-arm the OPT3001 interrupt and go into shutdown. The CC1310 will stay in
shutdown mode until the next OPT3001 interrupt. The OPT3001 is configured for its maximum conversion
time of 800 ms. Consequently, the CC1310 will wake up and transmit data every 800 ms when the light
level is outside the light thresholds set during the OPT3001 configuration.

NOTE: When CC1310 is in shutdown mode, JTAG will not be able to connect to the MCU. To use
JTAG, create a fault light condition to wake up the device before connecting with JTAG.

http://www.ti.com
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Figure 8. Firmware Flowchart
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5 Getting Started Hardware

5.1 Hardware Overview
Figure 9 shows the hardware for the Interrupt-Based Ambient Light and Environment Sensor Node for
Sub-1GHz Networks Reference Design TI Design. The printed circuit board (PCB) is in a 2.0×3.0-inch
rectangular form factor and comes with 0.5-inch nylon standoffs to ensure ease of use while performing
lab measurements.

Figure 9. Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz Networks
Reference Design Hardware

To power the system, pins 2 and 3 on jumper J4 must be shorted together with a jumper shunt. By doing
this, the output of the battery is directly connected to the sensor nodes and CC1310.
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5.2 Loading Firmware
The firmware used on this TI Design was developed using TI’s Code Composer Studio software
(version 6.1.0).

The IAR Embedded Workbench for ARM () also supports the CC13xx line of SimpleLink products.

Powering the board from 3.0 V is necessary and can be supplied at pin 3 on J4. The power supply return
or ground can be connected to TP4. Using an external supply is necessary because the battery may not
have enough capacity to power the CC1310 while it is in the programming mode.

The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J7 to the
SmartRF06 Evaluation Board (10-pin ARM Cortex Debug Connector, P418). See Figure 10 for a photo of
the correct setup for connecting the TI Designs hardware to the SmartRF06 evaluation board (EVM).

Figure 10. Connection of SmartRF06 EVM and TI Designs Hardware for Programming and Debugging

5.3 Receiving Data Packets
This TI Design is programmed to read light, relative humidity, and temperature data from the OPT3001
and HDC1000, respectively. The CC1310 then broadcasts that data as a non-connectable data packet.
The packets consist of two bytes for TI design identifier, two bytes of relative humidity data, two bytes of
temperature data, and two bytes of light data.

To verify the proper operation of the radio transmission, the following subsections describe two methods
to view the transmitted packet.

http://www.ti.com
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5.3.1 Building Automation Sub-1GHz Sniffer Application
The first method is a Sniffer application firmware running on the SmartRF06 EVM with the CC13xxEM
radio. The Sniffer application will process the received packet and display the calculated data on the LCD
screen.

The LCD screen will show the six most current received data. If more data is needed for testing or
characterization purposes, Section 5.3.2 describes how to get more data samples for post analysis.

Figure 11. Sniffer Application Firmware Running on the SmartRF06 EVM With TIDA-00758 and
TIDA-00488 Reference Designs

For more information about the Sniffer GUI, download and install the Building Automation Sub-1GHz
Sniffer software package available in Section 7.8 of the TI Design tools page.

http://www.ti.com
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5.3.2 CC1111 USB Dongle and SmartRF Protocol Packet
The second method uses the CC1111 USB Dongle. The CC1111 USB EVM Kit 868/915 MHz "sniffs"
packets using the SmartRF Protocol Packet Sniffer software. The data will be displayed as raw data
stream. This data stream can be post processed and used for testing and characterization. After installing
the packet sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data
transmissions:
1. Plug the CC1111 USB dongle into an unused USB port on the computer with the packet sniffer

software installed.
2. Open the packet sniffer software; choose "Generic" as the protocol and click the "Start" button (see

Figure 12).

Figure 12. Packet Sniffer Start Screen

http://www.ti.com
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3. Configure the CC1111 correctly to see the packets. Select the Radio Configuration tab. Under the
Register settings sub tab, click on the "Browse…" button. Open the TIDA-00488_CC1111.prs file.
Highlight and double-click on "TIDA-00488_CC1111" to apply the register settings shown in Figure 13.

Figure 13. Radio Configuration and Monitor Screen

NOTE: If long data acquisition periods are expected, increase the Cache Buffer size in the packet
sniffer software to prevent possible crashes. Take this action by opening the Settings menu
and clicking "Cache buffer size...".

http://www.ti.com
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4. Press the Play button on the top toolbar to initiate the packet capture process. An example is shown in
Figure 14.

5. The packet sniffer software is likely to detect many other packets. To view only the valid data packets,
apply a display filter.

Figure 14. Unfiltered Radio Data

http://www.ti.com
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6. The appropriate filter checks for only valid packets. In the Field Name field, select "FCS" from the
dropdown options. Click the button labeled "First." Modify the filter condition to only show "OK" packets
by typing "FCS=OK" in the Filter condition field, click the "Add" button, and then click the "Apply" filter
button. The screen capture in Figure 15 shows an example filtered view.

Figure 15. Filtered Radio Data

7. To export the captured filtered packets, click the "Save the current session" button on the toolbar
(appears as a floppy disk), or pause the packet capture and click File → Save data… from the file
context menu; either of these choices prompts to save the displayed data as a packet sniffer data
(.psd) file.

8. Use HexEdit software (http://www.hexedit.com/) to convert the .psd file to readable hex values. A
different hex editor may perform this function as well; however, the authors of this document have not
verified any other options.

9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window,
click on Document → Display and change the Columns value to "2066". Click Edit → Select All and
Edit → Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and
save the text file. This text file can then be imported into Microsoft® Excel® spreadsheet software for
further analysis. For more information on the sniffer data packet format, click Help → User Manual on
the packet sniffer software.

http://www.ti.com
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6 Test Data
The following tests were performed with a CR2032 battery installed. Radio transmission was verified by
using the method shown in Section 5.3.2.

6.1 On-State Power Characterization
The on-state duration and average current was characterized with the use of a Tektronix MDO3024 Mixed
Domain oscilloscope and a Tektronix TCP0030A current probe. The oscilloscope was connected directly
to a laptop through a USB cable and uses the corresponding software to directly export the recorded data
points. Figure 16 shows the current drawn from the coin cell battery, as measured through connector J4
pins 2 and 3.

Figure 16. On-State Current versus Time

By exporting the data into Microsoft Excel for analysis, the design team determined that the average
current over the first 53.7 ms of system operation was 1.78 mA. This current is considered the average
on-state current of the TI Design system.

6.2 Off-State Power Characterization
The off-state duration and average current was characterized with the use of a Keysight 34410A digital
multi-meter (DMM) with 6½ digits of resolution. The current drawn from the coin cell battery is measured
through jumper J4 pins 2 and 3. The average current for the system is 2.1 μA.
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6.3 Estimated Battery Life Calculations
The battery life for the TIDA-00758 depends upon a number of factors. As stated in Section 4.2, the time
between OPT3001 interrupts is 800 ms. To ensure long battery life, the system that receives the light
sensor information would need to adjust the light level within a few seconds to ensure the number of
interrupt cycles remains low and the battery life of the TIDA-00758 system is optimized. For the following
calculation, the assumption is that the light level will be adjusted by the host system within the time of two
OPT3001 interrupts and that there will be 12 transmissions of data in an hour.

As Section 4.1.1 shows, the equation used for estimating battery life of the TI Design system has five
parameters:
• Capacity rating of the battery in milliamp-hours (mAh)
• Average off-state current consumption (nA)
• Off-state duration (s)
• Average on-state current consumption (mA)
• On-state duration (s)

The on-state duration in one hour is 12 × 53.7 ms = 12 × 0.0537 s = 0.644 s. The off-state duration is
3,600,000 s – (12 × 0.0537 s) = 3,599,999.356 s.

As previously stated, the battery used in this TI Design is a CR2032 lithium-ion coin cell that has a
capacity rating of 240 mAh. The battery has a de-rating factor of 85%, which attempts to model the effects
of varying temperatures as well as battery self-leakage.

When using the measured values for the remaining parameters, Equation 2 shows the following battery
life calculation:

(2)

With 12 transmissions per hour, the battery life would be 9.63 years. The calculation above can be
adjusted for different numbers of transmission per hour by substituting the number for transmissions per
hour for 12 in Equation 2. Table 2 shows the results for several different numbers of transmissions per
hour. Figure 17 shows a graph of this data.

Table 2. Effect of Increasing Number of Transmissions
on Battery Life for TIDA-00758

NUMBER OF TRANSMISSIONS
PER HOUR

BATTERY LIFE ESTIMATE
(YEARS)

6 10.00
6.67 10.00
7.5 10.00

8.57 10.01
10 9.85
12 9.63
15 9.32
20 8.85
30 8.04
60 6.31

120 4.41
240 2.75
480 1.57

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS9B


Number of Transmissions per Hour

B
a

tt
e

ry
 L

if
e

 E
s

ti
m

a
te

 (
Y

e
a

rs
)

0 20 40 60 80 100 120
4

6

8

10

12

Test Data www.ti.com

24 TIDUAS9B–September 2015–Revised May 2016
Submit Documentation Feedback

Copyright © 2015–2016, Texas Instruments Incorporated

Interrupt-Based Ambient Light and Environment Sensor Node for Sub-1GHz
Networks Reference Design

Figure 17. Battery Life Estimation versus Number of Transmissions per Hour for TIDA-00758

The TIDA-00758 does not account for the time of day, nor does the system stop transmitting data after a
fixed number of transmissions have been made. A more comprehensive system implementation would
receive data as well as transmitting. This would allow the host system to update the light intensity trip
point limits at different times of day to keep the TIDA-00758 asleep during periods of time when changes
in light intensity would not matter or when low light levels were acceptable, such as in an office
environment during the night.

6.4 Light Level Trip Point Validation
There are two light level trip points programmed into the OPT3001. The lower limit is 250 lux and the
upper limit is 600 lux. The OPT3001 will not issue a processor interrupt if the light level is between 250
and 600 lux, but interrupts are issued every 800 ms if the light level is below 250 lux or above 600 lux.

Trip point operation was verified by controlling the light intensity shining on the board. Figure 18 shows the
setup for controlling the light level. Light levels were measured with an Extech Instruments model 407026
light meter. The primary light source during the tests was a Fostec Ace I adjustable light attached to a
microscope that could be raised and lowered to help adjust the light level. Some ambient light also made
up part of the incident light. The light level was measured near the center of the light spot provided by the
microscope light. The light meter sensor was then moved away and the TIDA-00758 system board under
test was placed with the OPT3001 positioned in the same spot as the light meter sensor. The sniffer
software described in Section 5.3.2 was used to monitor whether the system was transmitting or not. The
last two bytes of the transmission payload are the light level. The trip point values were confirmed by
translating the transmitted value to lux values and comparing the transmitted value to the trip point.

When the light level was near the trip point, the value reported by the TIDA-00758 system was very close
to what was read by the Extech meter. Table 3 summarizes the data.

Table 3. Light Level Measurement Comparison

TRIP POINT EXTECH METER
READING (lux)

TIDA-00758
AVERAGE ERROR

LOW READING (lux) HIGH READING (lux)
250 240 230.48 234.24 3.18%
250 255 246.30 249.60 2.76%
600 620 600.48 605.76 2.72%
600 648 633.00 637.00 2.01%
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The error between the values reported by the TIDA-00758 and the values reported by the Extech meter is
small. The sensor area of the OPT3001 is 0.39 × 0.49 mm, or 0.19 mm2. The sensor area of the Extech
meter is considerably larger. It has a diameter of 43.7 mm, so the area is 1500 mm2. This difference will
lead to performance differences between the two sensors.

Figure 18. Light Measurement Setup for Verifying the OPT3001 Trip Points
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7 Design Files

7.1 Schematics
To download the schematics, see the design files at TIDA-00758.

Figure 19. Power (Battery Input) Schematic
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Figure 20. Bluetooth® and Light Sensing Schematic
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7.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-00758.

7.3 Layer Plots
To download the layer plots, see the design files at TIDA-00758.

7.4 Altium Project
To download the Altium project files, see the design files at TIDA-00758.

7.5 PCB Layout Recommendations
To ensure high performance, the Interrupt-Based Ambient Light and Environment Sensor Node for Sub-
1GHz Networks Reference Design TI Design was laid out using a four-layer PCB. The second layer is a
solid GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The top
and bottom layers are used for general signal routing and also have GND fills in unused areas.

For all of the TI products used in this TI Design, follow the layout guidelines detailed in their respective
datasheets.

7.6 Gerber Files
To download the Gerber files, see the design files at TIDA-00758.

7.7 Assembly Drawings
To download the assembly drawings, see the design files at TIDA-00758.

7.8 Software Files
To download the software files, see the design files at TIDA-00758.
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